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Introduction
Existant depuis plus de cinq décennies, mais essentiellement ancré
dans l'industrie, le prototypage a évolué vers la technologie de
l'impression 3D. Elle se voit de plus en plus vulgarisée avec
l'apparition d'imprimantes 3D libre de source sur le marché . Il est
donc effectivement possible de se procurer les plans d'une
imprimante sous licence libre dans le but de la reproduire ou de s'en
inspirer pour en faire un modèle personnalisé.

Les objets 3D peuvent être conçus par nombre de logiciels de
modélisation à travers un long procédé. Ce processus de
prototypage se trouve accéléré en se tournant vers le logiciel
Blender.

Blender est un modeleur surfacique  à l'instar de Wings3D, Modo,
Cinema4D, XSI, 3DSmax, Maya,  plutôt que paramétrique ou
volumique comme FreeCAD, SolidWorks, Catia et Solid Edge entre
autres.

Structuré en trois grandes parties, ce livre s'adresse aux utilisateurs
qui modélisent des objets avec Blender ou qui récupèrent des objets
issus d'autres logiciels en vue de les imprimer.

Une première partie intitulée "Créer dans Blender" permet au
lecteur de pouvoir appréhender la méthodologie de création dans
Blender et de pouvoir le prendre en main afin de réaliser un objet
concret.

La deuxième partie nommée  "Importer et modifier dans Blender"
renseigne sur les étapes à suivre concernant l'importation de
fichiers 2D ou 3D avec Blender, de même que leur modification.

La troisième partie; "Exporter pour l'impression 3D" met la lumière
sur les diverses tâches à effectuer sur un maillage de sorte à
effectuer son exportation pour l'impression.

Dans l'optique de suivre et de répliquer aisément les exemples
montrés dans le livre, il est préférable de garder l'interface de
Blender en anglais.
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A propos
Cet ouvrage a été réalisé durant un libérathon* qui s'est tenu sur
quatre jours à Rennes; du 30 novembre au 3 décembre 2013. Initié et
soutenu par l'Organisation Internationale de la Francophonie (OIF*),
ce libérathon a connu la participation des co-rédacteurs suivants:

 

Ronan Ducluzeau, graphiste et formateur ;
Edddy Gautier, organisateur d'ateliers sur les logiciels 3D

libres et membre actif du BUGParis* ;
John Lejeune, coordinateur du labfab de Rennes ;
Cédric Gémy, graphiste et formateur ; 
Alexandre Penaud, étudiant en Sciences de l'Éducation ; 
Kossigan Roland Assilevi, Ingénieur Informaticien et

facilitateur ; 
Elisa de Castro Guerra, graphiste, formatrice et

facilitatrice.

Un livre vivant
N'hésitez pas à participer à cet ouvrage !

Faites-nous part de vos commentaires dans la liste de diffusion de
Flossmanuals francophone. Si vous avez des talents de rédacteur et
une bonne connaissance des sujets abordés, vous êtes les bienvenus
en tant que contributeur. Inscrivez-vous pour enrichir les contenus
et/ ou créer de nouveaux chapitres.

Ce livre libre est disponible sous plusieurs formats et supports : en
ligne, en html, au format pdf ou epub et en livre imprimé.

Publié sous licence G.P.L., ce livre peut être lu, copié et distribué
librement sous les mêmes conditions.

Vous consultez l'ouvrage publié le 7 décembre 2013.

La version de Blender utilisée pour les exercices est la 2.69. La
plupart des outils pour l'impression 3D sont apparus dans la version
2.67. Cependant, certains outils de modélisation utilisés dans les
exercices sont plus récents. Il est donc déconseillé de suivre le livre
sur une version antérieure à la 2.69. 
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Les mots suivis d'un astérisque (*) sont décrits dans le glossaire en
fin d'ouvrage.
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fin d'ouvrage.

CRÉER DANS BLENDER
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Configurer Blender
Blender est vaste et peut servir à tout ce qui touche à la 3D et à
l'animation. Il dispose donc de nombreux outils et fenêtres qui sont
utiles dans des contextes spécifiques. Nous allons montrer dans les
lignes qui suivent comment le configurer et orienter Blender en vue
d'imprimer les objets en 3D.

Configurer les zones 
Par défaut, l'interface à plusieurs aménagements de fenêtres
prédéfinis disponibles juste à droite du menu en haut de la fenêtre du
logiciel. L'aménagement [Default] est utilisé au lancement.

Leur nom rappelle vite l'usage principal pour lequel ils sont conçus.
Aucun n'est totalement adapté aux besoins de l'impression 3D. Nous
allons en créer un très simple, en partant de l'arrangement par
défaut, qui sera la meilleure base et de laquelle nous allons enlever
la timeline servant à l'animation. Pour cela, repérez la zone
horizontale en bas de la fenêtre et qui affiche des chiffres avec un
trait vert au niveau de 0. Deux solutions sont possibles :

Cliquez avec le bouton droit sur la ligne de séparation
entre cette zone et celle qui est dessus et dans le menu qui
apparaît, choisissez [Join Areas]. les trois petits traits
diagonaux en bas à gauche de la vue 3D sur la timeline;

Enfoncez les stries dans l'angle supérieur droit de cette
zone puis glissez vers le haut sur la zone supérieure pour
afficher l'outil de fusion puis vers le bas pour spécifier le
sens de fusion. Lorsque la grande flèche pointant vers le
bas apparaît, cette zone sera supprimée au lâcher de
souris. 

Configurer l'espace et les unités
Blender a, à l'origine, calqué son système d'unités sur les logiciels de
PAO et par conséquent, est configuré pour une échelle de 1 unité =
1mètre alors qu'en impression 3D la norme est de 1 unité = 1mm. Si
cela n'est pas très important en soi, la grille par défaut ne fait que 16
unités de larges. Pour y remédier, allez dans l'onglet [Display] du
panneau Propriétés (touche [N]) et augmentez le paramètre [Lines] à
200 (par exemple, si votre imprimante à un plateau de 20cm).
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Activer les add-ons utiles 
Il existe quelques addons qui pourront être pratiques à utiliser et que
vous pouvez d'emblée activer. Pour cela, allez dans [File > User
Preferences] ou [Ctrl Alt U] puis dans la section [Addons].

Un addon est spécialement conçu pour l'impression 3D, , mais le
travail devient beaucoup moins souple.Mesh: [3D print toolbox]
(boite à outils d'impression 3D), il ajoute un panneau de vérification
du maillage (assez similaire au Mesh analysis, que nous verrons en
partie 3, mais avec quelques fonctions en plus comme la sélection
des faces incriminées par un défaut ainsi qu'un rapport général sur
plusieurs paramètres).

Viennent ensuite plusieurs addons qui ne concernent pas
directement l'impression mais qui deviennent vite indispensables :

[Mesh : F2], addon permettant d'ajouter des faces de
façon très souple, je vous invite à regarder la vidéo
explicative de son auteur pour en comprendre le
fonctionnement: https://vimeo.com/57686760 ;

[Mesh: Looptool], qui est une boite à outils pour traiter
les boucles de vertex*, le relier, les arrondir et plein d'autres
chose ;

[Add mesh: Bolt factory], permettant de générer des
boulons et des pas de vis ;

[Add mesh: extra objects], permettant entre autres
d'ajouter des engrenages (gears) ;

tous les addons d'import dont vous pouvez avoir besoin
par rapport à vos autres logiciels.

Ensuite, toujours dans [User Preferences], mais dans la section
[system], si vous comptez traiter des maillages avec un grand
nombre de vertex (comme un scan haute définition ou un sculpt)
vous devez cocher VOBs qui met en cache vos objets afin d'avoir plus
de fluidité.

Voici un aperçu de l'écran avec lequel vous travaillerez.
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Enfin, il faut pour utiliser Blender à son potentiel maximum, disposer
d'un pavé numérique et d'une souris 3 boutons + molette. Il existe
deux options dans [Input] du [User Preferences] qui permettent de
les émuler : [emulate 3 butons mouse] qui permet de remplacer le
3ème bouton de la souris par [Alt+Clic gauche] et [emulate numpad]
qui remplace les chiffres du pavé numérique par les chiffres du haut
du clavier. Mais si vous devez utiliser régulièrement Blender nous
vous conseillons d'investir dans le matériel, vous gagnerez en temps
et en confort.

Une fois ces paramètres modifiés, en bas à gauche du [User
Preferences], appuyez sur [Save User Settings] pour sauvegarder les
préférences, sortez du panneau de préférence et enregistrez votre
fichier de démarrage (save startup file) avec le raccourci [Ctrl+U].,
mais le travail devient beaucoup moins souple.

8



Méthodologie
L'impression 3D demande de la patience et de la persévérance.
Chaque étape du processus requiert quelques heures de travail pour
aboutir à un résultat satisfaisant. Afin de vous éviter la déconvenue
de repartir plusieurs fois de zéro, ne lésinez pas sur les étapes de
vérifications et de surveillance.

Avant même d'ouvrir Blender, dans le cas d'un processus créatif ou
de la reproduction d'une pièce existante, commencez par coucher
votre idée sur papier.

Plus vous aurez précisé votre projet, plus vous réduirez les voies
d'abord. Il y a toujours différentes façons d'arriver à une forme.
Choisir la plus rapide n'est souvent qu'une question de culture et
d'expérience. Si vous avez besoin d'aide, vous serez plus à même de
l'expliquer à quelqu'un de plus expérimenté, capable de vous
aiguiller.

Une fois votre imprimante correctement calibrée ou les
renseignements sur le service d'impression collectés, le processus
de production se déroule selon les grandes sections du livre. Soit
vous créez de zéro votre forme, soit vous partez d'un fichier existant
à modifier. Puis vous évaluez que sa géométrie respecte des
contraintes d'impression. Et enfin, vous pouvez l'imprimer.

La durée de l'impression est dépendante du matériel et est
difficilement réductible sans diminuer la qualité du modèle. Alors que
la méthodologie de création du modèle peut prendre de plusieurs
heures à quelques dizaines de minutes en fonction de vos
connaissances de Blender.

En cas de blocage ou d'échec, identifiez le problème et persévérez. Si
vous ne trouvez pas la cause du problème vous-même, demandez de
l'aide, soit dans les forums d'entraide sur internet, soit dans un
FabLab près de chez vous. Plus vous pratiquerez la modélisation
avec Blender, plus vous serez à l'aise avec la réalisation de vos
propres projets. Il suffit souvent de quelques semaines de tutoriels
pour lever l'appréhension des débutants. Le manuel vous laisse
entrapercevoir des cas pratiques simples et vous donne déjà de
solides bases pour vous en éloigner un peu.

Pour aller plus loin, vous trouverez des tutoriels en français sur 
http://www.blenderlounge.fr et http://www.etude-blender.fr/ ou de
l'aide sur le forum http://blenderclan.tuxfamily.org
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Prise en main rapide
Blender peut sembler déroutant à l'ouverture. Ce chapitre va vous
guider dans sa prise en main.

Interface
L'interface de blender est extrêmement modulable. Cela permet de
l'adapter à son travail mais c'est également déroutant pour les
néophytes. L'espace de travail modifié au chapitre précédent
contient 3 éditeurs :

la vue 3D qui prend le plus d'espace.
l'outliner qui est un descriptif du contenu du fichier.
l'éditeur des propriétés. Vous y modifierez les données de

la scène ou celles de l'objet.

Blender utilise d'autres éditeurs sans lien avec l'impression 3D pour
des tâches spécifiques comme l'animation ou le montage vidéo.
Cependant, pour colorer ou modifier un objet, vous pourrez être
amené à aussi utiliser l'UV/Image Editor présent dans l'écran UV
editing.

Pour changer la nature d'un éditeur, il suffit de cliquer sur l'icône de
l'éditeur présent dans son header à gauche.

Tapez la combinaison [Maj Espace] pour maximiser ou minimiser un
éditeur.
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Cliquez sur l'icône correspondant au type de données à modifier. Les
informations affichées dans l'interface s'adaptent d'après l'objet actif
sélectionné.

Dans l'outliner, cliquez sur le nom d'un objet pour le sélectionner.

Cliquez sur l'œil pour masquer un objet dans la vue 3D.
Cliquez sur la flèche pour empêcher la sélection de

l'objet dans la vue 3D.

La vue 3D comporte deux colonnes latérales.

La colonne de droite, celle des propriétés de la vue, peut
être masquée/affichée avec la [N].

On y gère l'affichage dans la vue 3D (grille , panneau Mesh
Analysis).

La colonne de gauche, celle des outils, peut être
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La colonne de gauche, celle des outils, peut être
masquée/affichée avec [T ].

les outils de modélisation y sont accessibles sous forme de
boutons cliquables. Les panneaux add-ons utiles pour
l'impression 3D s'y affichent également.

la colonne de gauche contient également une région en
bas pour modifier les paramètres du dernier outil utilisé.

Les panneaux présents dans les colonnes comme les outils sont
spécifiques.

À gauche, la colonne d'outil en Object Mode. À droite, la même
colonne en Edit Mode.

Les modes

Suivant la modification apportée à un objet, les manipulations
seront à effectuer dans le mode dédié.

Mode objet (object mode) : c'est le mode par défaut. Il
sert à pratiquer des transformations de base (déplacement,
rotation). Passer en Object Mode peut être considéré
comme une validation des modifications faîtes dans un
autre mode.

Mode d'édition (edit mode) : ce mode comprend le plus
d'outils de création et modification de la géométrie. C'est
dans ce mode que se fait le nettoyage du maillage final.

Mode de sculpture (Sculpt Mode) : il permet de générer
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dans ce mode que se fait le nettoyage du maillage final.
Mode de sculpture (Sculpt Mode) : il permet de générer

ou affiner le maillage comme si on sculptait dans de la
glaise.

Mode de peinture de vertices (Vertex Paint): on y peint à
une résolution limitée à la géométrie de l'objet. Une
couleur est stockée pour chaque vertex. C'est une
technique plutôt utilisée pour le jeu vidéo. Ce type de
couleur n'est pas supportée pour les impressions couleur.

Mode de peinture de texture (Texture Paint) : il permet de
peindre dans la vue 3D un fichier image appliqué à la
surface de l'objet par le biais des coordonnées UV. Le fichier
image de la texture sera exploité pour l'impression des
couleurs.

Mode de peinture de la pondération (Weight Paint) : c'est
un mode indispensable à la réalisation d'animations pour le
cinéma ou le jeu vidéo.. Mais à moins de s'en servir pour la
création de vertex groups pour limiter l'influence d'un
modificateur, il n'a pas d'intérêt pour l'impression 3D.

Se déplacer et manipuler dans la vue 3D
Dans blender, le bouton droit de la souris est utilisé pour
sélectionner les éléments. Le bouton gauche sert à déplacer le
curseur3D, valider les actions ou à définir des tracés de peinture ou
de sélection. Et la molette de la souris  est utilisée comme un
troisième bouton pour pivoter, se déplacer ou zoomer dans la vue.

Faire un clic maintenu sur la molette pendant que vous déplacez la
souris pour tourner autour d'un objet. Faire le même genre de clic
mais en maintenant la touche Shift enfoncée en même temps pour
déplacer latéralement la vue sans changer l'orientation du point de
vue. Faire la même chose mais en maintenant [Ctrl] enfoncée pour
zoomer ou dézoomer suivant le sens du déplacement de la souris.

Utilisez les touches du pavé numérique pour remettre la vue 3D
dans une vue standard.vue de face (Front) : 1     vue arrière (Back) :
Ctrl  vue de droite (Right) : 3  vue de gauche (Left) : Ctrl 3 
Vue du dessus (Top) : 7   vue de dessous (Bottom) : Ctrl 7

[NumPad 5] du pavé numérique permet basculer d'une vue
perspective à une vue orthographique.
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[NumPad 2], [NumPad 4], [NumPad 6] et [NumPad 8] font pivoter la
vue de quelques degrés dans le sens de la flèche qui leur est
associée.

[NumPad .] du pavé numérique recadre la vue au niveau de l'objet
sélectionné.

[Home] recadre la vue pour englober tous les objets de la scène.

La combinaison [Maj C] fait la même chose mais recentre également
le curseur 3D aux coordonnées (0,0,0). Le curseur 3D se déplace
facilement en faisant un clic gauche dans la vue 3D.

La combinaison [Maj B] appelle l'outil de zoom sur une région
rectangulaire à définir par un clic gauche lors du déplacement de la
souris.

[B] appelle un outil identique mais pour sélectionner les éléments
présents dans la zone rectangulaire définie.

[A] permet de tout sélectionner ou désélectionner.

Placer la souris au-dessus d'un élément et faire un clic droit permet
de le sélectionner. Refaire la même manipulation mais avec la
[touche Shift] permet d'étendre la sélection à un second élément ou
de désélectionner un objet en conservant le reste de la sélection.

Les 3 transformations de base sont la translation (Translate [G]), la
rotation (Rotate [R]) et la mise à l'échelle (Scale [S]). Elles peuvent
également être effectuées grâce au manipulateur correspondant.

Pour valider certaines actions, un clic gauche ou une pression sur la
[touche entrée] peut être nécessaire. Au contraire, pour annuler une
manipulation en cours , il faut utiliser [Echap] ou faire un clic droit.

Blender utilise aussi des raccourcis clavier standard : [Ctrl Z] pour
annuler une action validée, [Ctrl N] pour un nouveau fichier, [Ctrl O]
pour ouvrir, [Ctrl S] pour sauvegarder, [Ctrl C] pour copier et [Ctrl V]
pour coller.

Si vous souhaitez récupérer un objet à partir d'un fichier .blend destiné
à de l'illustration; décocher la case Load UI dans la toolbox évite de
lancer l'interface du fichier pour conserver la vôtre définie pour
l'impression 3D. 
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l'impression 3D. 
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Créer un premier objet
En tant que suite 3D complète, Blender permet de créer des objets
3D à partir de zéro. Il regorge d'outils permettant de réaliser tout
type de formes. On distingue plusieurs types d'objets 3D gérés par
Blender pour différents usages (l'impression 3D, mais aussi le jeu
vidéo, les illustrations ou les films d'animation, etc.). Parmi tous ces
types d'objets, il y a 3 principales catégories permettant de produire
de la géométrie : les surfaces NURBS, les courbes de Bézier et les
maillages (Mesh). Quelle que soit la catégorie utilisée comme point
de départ de votre création, celle-ci doit toujours aboutir (être
convertie) en un objet de type maillage pour l'impression 3D.

L'édition d'un maillage dans Blender est aussi plus généralement
appelée modélisation polygonale.

La modélisation est un vaste sujet. Le chapitre du wiki officiel est assez
complet en anglais mais n'est pas traduit en
français http://wiki.blender.org/index.php/Doc:2.6/Manual.
Cependant, comme il s'agit d'une étape primordiale pour la plupart des
travaux en 3D. Elle est traitée dans la majorité des tutoriels disponibles
sur internet. 

Afin d'appréhender quelques outils de la modélisation polygonale
dans Blender, voici un didacticiel pas à pas pour créer un badge
portant un prénom.

Premièrement, vous allez créer le support ovale du texte. Dans un
fichier vierge, passez la vue 3D en vue de dessus [NumPad 7]. Si votre
fichier de base contient un cube, sélectionnez le d'un clic droit [RMB]
et [x]. Quittez la vue perspective pour une vue orthographique
[NumPad 5]. Grâce au menu Add [Maj A >Mesh>Cylinder], ajoutez un
cylindre avec les paramètres suivants que vous pouvez saisir dans le
bas de la boîte à outils sur la gauche de la vue 3D ou en appuyant
sur F6 : nombre de sommets [Vertices] 64, rayon [Radius] 1,
profondeur [Depth] 0.3, mode de fermeture des extrémités [Cap Fill]
Type Ngon.
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Pour modifier la largeur de l'objet, faire une mise à l'échelle
contrainte sur l'axe X avec l'outil Scale en tapant la suite [S X 2
Entrée].

À présent, il faut ajouter une petite partie trouée qui permettra la
fixation du badge par le biais d'un fil ou de tout autre type d'attache.

Basculez en mode Édition avec [Tab].

Ajoutez un cylindre [Maj A>Mesh>Cylinder] avec les réglages
[Vertices] 16, [Radius] 0.15, [Depth] 0.3, [Cap Fill] Type Nothing,
[Location] X 0.345, Y 1.3, Z 0.

Extrudez les faces sélectionnées du petit cylindre [E] et sans
déplacer la souris sortez de la fonction en utilisant un clic droit ou
[Echap]. Nous avons alors créé des faces qui sont positionnées par-
dessus leurs originales.

Élargissons les faces extrudées en faisant une mise à l'échelle de la
sélection [S], contrainte dans le plan XY [Maj Z 2] .
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Passez en mode de sélection de faces [Ctrl TAB] et en visualisation fil
de fer [Z]. Avec la combinaison de [Ctrl] et du clic gauche,
sélectionnez 3 faces sur chaque partie, la petite et la grande, l'une
en regard de l'autre; et n'hésitez pas à zoomer avec la molette pour
gagner en précision. Puis supprimez les avec [X] et sélectionnez
[faces].

Tournez la vue autour de l'objet en déplaçant la souris et en
maintenant la molette enfoncée, observez le résultat. Repassez en
mode sélection de vertices [ctrl TAB>Vertex].

Activez les boutons de l'accrochage Snap (aimant) et de fusion
automatique des vertices [Automerge Editing] (double flèche) dans la
barre de l'en-tête de la vue 3D.
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Pour fusionner les vertices des deux formes, déplacez-les un à un [G]
pour joindre les vertices de l'ouverture du petit cylindre et ceux de
l'ouverture du grand cylindre. Pour vous aider, souvenez-vous que le
magnétisme de l'aimant est calculé par rapport à la position de la
souris, et non celle du point en déplacement. Blender entoure d'un
petit rond les points qu'il est prêt à fusionner : vous pouvez alors
valider d'un clic gauche si la position est bonne.

À partir de ce moment, le magnétisme peut être désactivé. En mode
de sélection de face [Ctrl TAB>faces], sélectionnez la face supérieure
du badge d'un clic gauche et supprimez-la [x>Faces].

Le maillage est alors ouvert. Les arêtes de l'ouverture sont alors
qualifiées d'edges non manifold, c'est-à-dire qu'il peut y avoir pour
Blender une indécision à savoir si certaines faces sont à l'intérieur ou
à l'extérieur.

Passez en mode sélection d'arêtes [Ctrl TAB Edge] pour sélectionner
les arêtes de l'ouverture avec le menu [Select>Non manifold] ou
[Maj Ctrl Alt M].
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Afin de refermer le maillage, utilisez la recherche [barre espace]
pour appeler l'outil Grid fill (span 16). Activez l'option Simple
Blending pour un peu plus homogénéiser la taille des faces créées
par le Grid Fill. Modifiez le paramètre offset si besoin pour aligner
les arêtes de la grille créée.

Le Grid Fill est un outil apparu dans la version 2.68. Il ne permettait
alors que de joindre 2 boucles d'arêtes et non pas de remplir un trou.
Dans la 2.68, il aurait fallu désélectionner 2 edges face à face pour
changer la sélection du edge loop en 2 edge loops constitués du même
nombre d'edges. 

Basculez en mode objet [TAB] et ajoutez un objet texte [Maj A > Text]
à la position [location] X=0, Y=-0.2 , Z=1

Dans les propriétés du texte (icône du F), dans l'encart [Align] du
panneau [Paragraph], cliquez sur le bouton [Center] pour centrer le
texte au-dessus du support à partir de son point d'origine.
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Passez l'objet texte en mode Édition [TAB] puis écrivez au clavier le
nom ou prénom de votre choix. Repassez en mode objet [TAB] et
étendez la sélection d'objets au maillage en faisant Clic droit + [Maj]
enfoncé. Le maillage devient l'objet actif. Nous allons repasser une
nouvelle fois en mode Édition [TAB] et, en vue de dessus [NumPad 7],
utiliser la recherche [barre espace] pour appeler l'outil [Knife
Project]. Cet outil permet de découper le maillage existant pour y
insérer des faces correspondant à la projection du texte suivant la
vue. Le texte n'a donc pas besoin de toucher la forme du médaillon,
mais il est important que les deux soient superposés dans la vue.

Extrudez les faces présélectionnées du texte [E] d'une valeur 0.15.

Repassez finalement en mode objet.

Et voilà pour la réalisation d'un modèle 3d complet. Il ne vous reste
plus qu'à le soumettre aux vérifications d'usage d'un export pour une
impression 3D.
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Ici, l'exemple concerne un texte mais le Knife Project est également
fonctionnel avec les objets courbes abordés dans le chapitre Importer
un modèle 2D. La même démarche est donc reproductible pour un logo.
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Donner une épaisseur
Les formes créées dans Blender n'ont par défaut aucune épaisseur.
Les faces sont plates et les arêtes sont sans "matière". Aussi il va
être important de définir cette propriété de manière à ce que
l'imprimante puisse savoir quelle quantité de matière associer à la
surface. Dans Blender, cela passera par le modificateur Solidify pour
les faces, ou Skin pour les arêtes.

Épaissir une face avec Solidify
Dans l'exemple suivant, nous allons créer un mug. Il s'agit d'un objet
relativement simple à modéliser à partir de zéro. C'est aussi objet de
base de l'impression 3D.

Il y a plusieurs méthodes pour réaliser un objet de ce type : nous
utiliserons ici volontairement le spin qui permettra de dessiner
l'ensemble de notre mug en se basant sur un profil simple à partir
duquel les faces seront générées. Cette méthode pourra être utilisée
pour tout objet de ce type (tasse, vase, verre, plats..).

Dans un nouveau fichier, supprimons le cube par défaut [x] et
partons d'un simple plan [Maj A][Mesh][Plane].

Appuyez sur [tab] pour passer en mode Édition, sélectionnez trois
vertex avec le clic droit [RMB] et supprimez-les avec la touche [x].

Il reste alors un seul vertex que vous pouvez placer au centre de la
scène avec le menu Snap [Maj S][Selection to cursor]. Si le vertex est
mal placé, c'est certainement qu'un clic gauche malencontreux a
déplacé votre curseur 3D. Vous pouvez le rétablir à l'aide de [Maj C]
et retourner dans le menu Snap ou définir les positions X et Y du
vertex à 0 dans la partie supérieure de la fenêtre Propriétés [N].

Passez alors en vue de face [NumPad 1] ou [View>Front] et extrudez
le vertex jusqu'à obtenir la moitié de la silhouette : Touche [E] pour
extruder, puis [G] pour déplacer, autant que nécessaire en donnant le
profil qui vous plaît. Pour vous aider à être plus précis, passez
éventuellement en vue Orthographique [View>Persp/Ortho] ou
[NumPad 5].
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Nous allons maintenant créer les faces à partir de ce profil. Nous
allons à présent utiliser la fonction Spin qui est appliquée en
fonction de la vue. Passez en vue de dessus [NumPad 7] pour faciliter
la répétition. Toujours en mode Edit, sélectionnez tous les vertex [A].

Dans la ToolBox [T ], cliquez sur le bouton [Spin] dans le groupe
[Add]. Une première répétition par défaut s'effectue. En bas de la
boîte à outils, les paramètres du Spin sont apparus : notez par
exemple 18 en [Steps] et surtout 360 en [Degrees] de manière à ce
que nous ayons bien un tour complet.
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puis [w][Remove Doubles]. Blender affiche temporairement le
nombre de vertices supprimés dans la barre de menu.

Tournez maintenant librement autour de votre objet pour l'observer
ou l'adapter ici ou là.

Pour ajouter un peu de précision à notre maillage, utilisons le
modificateur [Subdivision Surface], souvent abrégé en SubSurf, placé
dans la seconde colonne [Generate]. Le réglage [View] mentionne 1
et [Render] 2. Le réglage de rendu n'est pas utilisé dans la vue 3D. En
général [View] est inférieur pour permettre une plus grande rapidité
des calculs lors de la phase de modélisation. Dans notre cas, nous
allons l'augmenter à la fois pour mieux voir le résultat final, mais
aussi pour préserver cet aspect lors de l'export en STL pour
l'impression.

Maintenant que notre objet est réalisé, nous pouvons lui appliquer le
modificateur [Solidify] placé juste au-dessus de SubSurf. Les réglages
sur lesquels porter notre attention sont les suivants :

[Thickness] pour définir l'épaisseur en tant que telle. S'il
n'y a pas de limite maximale, il nous semble cependant
important de faire attention à l'épaisseur minimale qui ne
doit pas être inférieure à la finesse d'impression de votre
imprimante 3D.

Les réglages [Crease] donnent des précisions sur le
positionnement et l'angularité des extrémités. Si votre
extrémité vous semble trop plate, vous pouvez inverser
l'ordre des modificateurs en cliquant sur les petites flèches
triangulaires placées à droite de la fenêtre du modificateur.

[Even Thickness] va rendre constante l'épaisseur sur
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triangulaires placées à droite de la fenêtre du modificateur.
[Even Thickness] va rendre constante l'épaisseur sur

toute la surface. Elle n'est pas nécessaire, mais peut éviter
des mauvaises surprises dans les objets à formes complexes
qui risqueraient alors d'avoir des zones trop peu épaisses.

[Fill Rim] est coché par défaut. Il sert à fermer l'épaisseur
avec une face.

Le réglage [Clamp] permet de serrer ou desserrer la
solidification en relation avec l'Offset. Jouer sur ce
paramètre permet d'éviter certains problèmes
d'intersection comme il sera vue au chapitre Nettoyer son
maillage. 
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Une fois imprimé, voilà le résultat.

Skin
Si votre objet est plutôt constitué d’arêtes ou que ses faces ne vous
intéressent pas dans le cadre de votre impression, le modificateur
Skin permet d'obtenir un résultat intéressant en donnant une
épaisseur. Voici un exemple simple pour illustrer son utilisation en
construisant une structure filaire à base d'une sphère.

Pour commencer, ajoutez une icosphere [Maj A>Mesh>Icosphere].
Vous pouvez modifier le nombre de subdivisions ainsi que sa taille
dans les options de la boîte à outils. Ici, notre taille est de 10.
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Allez à présent dans le panneau des modificateurs et ajoutez un
[Skin], placez dans la colonne [Generate], au-dessus de [Solidify], vu
précédemment. Immédiatement, vos faces disparaissent et vos
arêtes prennent du relief.

En mode Edit [TAB], appuyez sur [Ctrl A] et éloignez ou approchez la
souris pour modifier l'épaisseur des branches. Pour plus de
précisions, vous pouvez aussi utiliser les réglages [Vector] dans le
panneau [Skin Resize] de la boîte à outils.
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Le résultat est très anguleux. Vous pouvez utiliser le modificateur
Subdivision de Surface pour affiner les faces. Vus pouvez aussi
appliquer des épaisseurs différentes en appliquant l'option Skin
Resize [Ctrl A] à une sélection.
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En allant sur ce lien http://www.blendernation.com/2011/03/11/skin-
modifier-development ; vous découvrirez un petit exemple du
développeur de la fonctionnalité Skin, montrant un résultat
sympathique et un peu différent.
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Le modificateur est une solution très intéressante parce qu'elle facilite
la retouche de l'objet. Vous pouvez cependant arriver à un résultat de
ce type en mode Edit; en appuyant sur la barre espace, écrivez Wire et
activez l'option Wire Frame sélectionnée.
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activez l'option Wire Frame sélectionnée.

IMPORTER ET MODIFIER DANS BLENDER
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Comment importer
Dans ce chapitre, nous allons voir comment importer un fichier
dans Blender, ainsi que les formats d'importation majoritairement
utilisés dans le cadre de l'impression 3D.

De base, Blender offre différents formats d'importation.

Le .bvh (Motion Capture) ne contient que des données d'animation
et n'a aucun intérêt pour l'impression 3D. 

Le .svg (Scalable Vector Graphics)  permet d'importer des fichiers
vectoriels sous forme d'objets courbes. Cela génère une base rapide
pour des formes extrudées et nous en parlerons dans le chapitre sur
l'importation de fichiers vectoriels 2D.

Les formats suivants permettent d'échanger de nombreuses
données ( des maillages, des matériaux, et/ou des animations ) :

.dae (Collada)

.fbx (Autodesk FBX)

.x3d/.wrl (X3D Extensible 3D)

 Les formats les plus courants comportent généralement
seulement les données relatives au maillage : 

.ply (Stanford)

.stl (StereoLithography)

.3ds (3D Studio) 

.obj (Wavefront)

Pour importer un fichier, allez dans le menu Fichier>Importer
[File>Import]. Tous les formats par défaut sont listés.

 

D'autres formats pour l'importation ou l'exportation pourront être
rajoutés en activant des extensions (Addons) en général fournies
mais désactivées par défaut. Pour les rendre disponibles, il faut
passer par le menu Fichier> Préférences de l'utilisateur [File>User
Preferences] pour ouvrir la fenêtre des préférences. Les filtres
d'import sont listés dans la catégorie Import/Export. Il suffit de
parcourir la liste et de cliquer sur la case d'activation s'ils vous
intéressent. Si vous ne trouvez pas directement ce que vous
cherchez , vous pouvez aussi utiliser le champ de recherche en haut
à gauche de la fenêtre et y écrire votre mot-clé, par exemple DXF.
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Une fois activé, l'add-on sera disponible dans son menu. Pour savoir
exactement où le trouver, lisez le descriptif de l'add-on et repérez
l'information Location, spécifiant l'entrée de menu exacte. Dans
l'exemple suivant, le dxf apparaîtra dans [File>Import>Autodesk
(.dxf)].

Le format .lwo (Ligthwave Objects) permet également d'importer
des maillages 3D. Le format .dxf est également un format répandu,
surtout pour importer des objets courbes 2D. Il existe des formats
correspondant à des logiciels plus spécifiques comme le .mhx
(MakeHuman) qui permet d'importer des modèles d'humains
provenant du logiciel libre MakeHuman. 
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Importer un modèle 3D
Nous allons prendre l'exemple d'un fichier au format STL (une
voiture récupérée sur http://www.thingiverse.com/thing:45449)

Après extraction de l'archive récupérée dans le dossier de votre
choix, doit apparaître un (ou des fichiers) au format STL. Ce sont les
modèles 3D. 

Pour importer un modèle 3D (au format STL), il faut donc se rendre
dans le menu d'import [File>Import] et choisir [Stl (.stl)] :

Naviguez alors dans vos dossiers jusqu'à votre fichier STL présent
sur votre ordinateur et sélectionnez-le par un double-clic.

Voilà, le fichier est importé dans Blender !

37

http://www.thingiverse.com/thing:45449


Lors de l'importation d'un modèle 3D, il se peut qu'il ne soit pas
visible dans sa globalité. Ceci est dû à la taille de l'objet qui est trop
grande ou trop petite par rapport à votre vue par défaut dans
Blender.

Voilà le résultat après avoir divisé par 10 la taille de l'objet en tapant
la [touche S] et la valeur 0.1.

Chaque logiciel 3D a ses propres préférences en matière d'unités de
mesure. 
Un architecte préférera travailler sur un logiciel où l'unité de base
sera le centimètre ou le mètre. 
Alors que l'utilisateur d'une imprimante 3D préférera des mesures
exprimées en millimètres. 
Par défaut, Blender utilise un système de mesure arbitraire. 
Il faut donc s'attendre à ce que, suivant la provenance du modèle
importé,  la correspondance soit de 1 unité soit égale à 1 mm ou à
1m.

Le panneau [Units] des propriétés de la scène règle l'affichage des
unités dans l'interface. Les valeurs de dimensions dans les différents
champs s'accompagnent alors d'une abréviation marquant l'unité
utilisée de manière à éviter toute confusion.  
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Au lieu de valeurs avec une décimale, exprimée selon une seule
unité; la case [Separate Units] permet d'afficher les sous-unités. 
Passer la valeur [Scale] dans le panneau [Units] modifie l'échelle
générale de toute la scène. Dans cet exemple, en notant 0.01, cela
revient à changer les mètres en centimètres et les décimètres en
millimètres sans pour autant avoir besoin d'agir sur les unités elles-
mêmes.

La voiture importée mesure en longueur en Object Mode 10m 8,2cm
de long. 
Cependant, si on la mesure en Edit Mode : la valeur indiquée
correspond à 100m 82cm.
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Cela est dû à la mise à l'échelle en Object Mode. Elle ne modifie en
rien les données locales du maillage mais les données de l'objet
utilisant ce maillage dans la scène.

Blender est un logiciel dont les applications ne se limitent pas à
l'impression 3D. Pour un jeu ou une animation, il peut être
intéressant de partager les mêmes données de maillage entre
différents objets à différentes échelles. 
Afin de garder une cohérence entre les données locales en Edit
mode et les données globales en Object mode, observez deux règles
simples :

Règle 1 : Ne jamais faire de mise à l'échelle en Object
mode mais toujours en Edit mode.

Règle 2 : Si la règle 1 n' pas été respectée ; en Objet
mode, réinitialiser l'échelle avec la combinaison [Ctrl A >
Apply Scale].

Pour plus de simplicité, il est préférable de ne pas utiliser le panneau
[Units], de conserver toutes les valeurs d'échelle [Scale] à 1 et de
considérer l'unité arbitraire de Blender comme unité pertinente.

Lorsqu'un dessinateur veut représenter ce qu'il voit; il va utiliser son
crayon et son pouce pour prendre des mesures relatives. Pour
représenter quelque chose de reconnaissable, il faut essayer de
respecter ses proportions. Pour une voiture de 1,5 mètre de large, si
le rétroviseur fait 15 cm de long; il suffit de conserver un rapport de
10 en unités blender entre la taille de la voiture et celle du
rétroviseur pour que le modèle reste reconnaissable. 
Il en ira de même pour tout ce que vous souhaiterez représenter
fidèlement.

  
Pour l'impression 3D, considérez les valeurs affichées comme
exprimées en millimètres au moment de l'export.
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Quelques exemples de
modèles 3D
Les domaines d'application de l'impression 3D sont aussi immenses
que variés; les objets 3D modélisés et imprimés n'ayant que pour
seule limite la créativité de leurs auteurs. Ce chapitre, loin d'être
exhaustif, met en exergue quelques modèles que vous retrouverez
probablement sur le Net.

Tout comme la plupart des outils numériques, ceux-ci se sont
répandus un peu partout et impactent un large éventail de
professions. Que vous soyez architecte, designer, graphiste,
prothésiste, artiste, médecin, enseignant ou bien chercheur,
maquettiste ou simplement passionné, adolescent ou retraité, qu'il
s'agisse de biologie, d'architecture, de science et de mécanique, vous
trouverez à coup sûr une application pratique de l'impression 3D à
votre domaine de prédilection.

C'est dans la catégorie des figurines, jeux, jouets et objets amusants
ou improbables que vous trouverez le plus d'exemples. 

Cette figurine d'écureuil par DanielFC10 est disponible au
téléchargement sur le site blendswap.com. Conçue à l'origine pour
le rendu 3D, elle n'est pas encore préparée pour l'impression 3D.
Mais grâce a cet ouvrage, vous ne devriez plus tarder à pouvoir
préparer un tel fichier pour l'impression.

 

Il existe aussi des dépôts où vous trouverez des fichiers plus orientés
vers l'impression direct des modèles 3D. Par exemple
youmagine.org d'où provient l'exemple ci-après. 
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Une vue topographique du mont Jendemscellet, en Norvège. Ce
modèle sous licence CC-BY provient du site youmagine.org 

 

Le plus connu de tous ces dépôts reste pour l'instant
thingiverse.com. C'est actuellement là que vous trouverez le plus de
catégories disponibles et de modèles imprimables. 

Un modèle de charpente trouvée sur thingiverse.com. Cette
structure à la saveur Voronoï est sous licence CC-BY-SA.

 

 Quelque soit votre source, notez bien que les fichiers proposé par la
communauté d'utilisateurs ne sont pas toujours "prêt à cuire". Il
faudra parfois les modifier à votre goût ou selon vos besoins. Vous
trouverez parfois des fichiers fournis bruts, dans un format souvent
propriétaire ou exotique, qu'il vous faudra convertir avant de pouvoir
l'importer dans Blender. 
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Importer un modèle 2D
Ce n'est pas parce que la 3D existe que la 2D en est pour autant
bannie. De nombreux fichiers n'ont actuellement de sens qu'en 2D
(photos, logos...), mais peuvent avoir un intérêt à passer à la 3D, y
compris à l'impression. Nous verrons dans ce chapitre comment
importer des dessins vectoriels 2D ainsi que des images bitmap pour
les utiliser dans Blender avant de les imprimer.

Importer un dessin vectoriel SVG
Dans de nombreux cas, il sera nécessaire de partir d'un dessin
vectoriel 2D créé par un logiciel dédié comme Inkscape
(téléchargeable sur le site officiel www.inkscape.org); ou de
l'exporter à partir d'une autre application CAD. Les formats
supportés par Blender pour l'import de fichiers vectoriels ne sont
pas nombreux. Le seul qui soit spécifiquement implémenté est le
SVG.

Le SVG (Scalable Vector Graphics) est une recommandation du W3C
accessible en ligne à l'adresse http://www.w3.org/TR/SVG/. Une
traduction en français un peu ancienne est disponible sur le site
http://www.yoyodesign.org/doc/w3c/svg1/. Le SVG est en constante
discussion depuis 1998. La première recommandation basée sur une
proposition d'Adobe est parue en 2001 et a depuis subi plusieurs
mises à jour partielles. SVG a été conçu pour être un format
d'échange universel, pratique à utiliser sur le web. Les fichiers SVG
sont de la famille XML, composée d'un fichier texte interprétable et
modifiable ; lisible par tout navigateur web. Le SVG s'impose peu à
peu comme un format d'échange important, mais aussi comme un
format de publication par défaut pour les dessins vectoriels, en
particulier dédiés à l'édition électronique. Encore rare il y a quelques
années, il fait maintenant partie de la boîte à outils de tout logiciel
performant et Blender n'échappe pas à la règle.

Ainsi, même si Blender dispose d'outils permettant d'éditer des
courbes de Béziers ou autres formes de courbes vectorielles, les
fichiers fournis au format SVG réalisés dans d'autres logiciels seront
fréquents et surtout ces logiciels peuvent fournir des outils bien plus
pratiques dans le dessin 2D que Blender lui-même.

En général, les formes ainsi importées dans Blender seront
extrudées, parfois combinées à d'autres formes, selon les besoins et
les objectifs.

Dans l'exemple suivant, nous partirons du logo de FlossManuals
francophone conçu en deux couleurs, et pour faciliter l'utilisation
dans Blender, nous avons combiné toutes les formes de même
couleur entre elles.
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Dans un nouveau fichier Blender, supprimez le cube par défaut,
placez-vous en vue de dessus [NumPad 7] ou [View>Top] pour mieux
voir ce qui va être importé.

Allez alors dans [File>Import>Scalable Vector Graphics (.svg)].
Naviguer alors les dossiers pour récupérer le fichier SVG. Il
apparaîtra alors au centre de la scène. Sa dimension sera peut-être
trop petite pour le voir correctement. N'hésitez pas à zoomer.
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Si nécessaire, dé-zoomez pour voir l'intégralité de la scène puis
placez la souris au plus près de l'origine (petit rond orange).
Sélectionnez l'ensemble des formes et mettez le logo à une échelle
correcte manuellement avec [S] et en éloignant progressivement la
souris. Vous pouvez vous y reprendre en plusieurs fois et déplacez-le
si besoin avec [G].

Nous avons ici l'impression que le texte a disparu, mais un affichage
rapide en mode filaire [Z] nous montrera qu'il est bel et bien présent.
En passant en mode Édition, on voit les courbes de Bézier
apparaître. Il est alors possible d'adapter la forme si besoin en
manipulant les poignées.

Les courbes récupérées du SVG

Sélectionnez maintenant la forme noire avec un clic droit [RMB] et
dans le panneau de propriété Path, à droite de l'espace 3D,
augmentez légèrement le réglage Extrude en le passant par
exemple à 0.002. Vous ne voyez pas encore les modifications. Passez
en vue de face [NumPad 1] ou de côté [NumPad 3] et voyez
l'épaisseur extrudée. Celle-ci sera très claire en mode filaire [Z].

Sélectionnez alors le texte et extrudez-le de la même façon en
passant le réglage à 0.003 ; on peut voir que la partie blanche du
logo représentant le livre est extrudée simultanément
conformément à la préparation de notre fichier dans Inkscape.
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Tout cela est bien, mais en y regardant de plus près un petit
problème se pose : repassez en affichage solide [Z] et allez en vue de
côté [NumPad 3] ou orthogonale [NumPad 5]. On peut voir que la
forme a été extrudée des deux côtés de la courbe 2D, ce qui fait que
la forme blanche et la forme noire ne sont pas alignées au sol l'une
avec l'autre. Si cette configuration est possible, il ne faudra pas
oublier de repositionner [G] éventuellement les formes pour les
aligner correctement d'un côté.
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Exporter directement des objets courbes de bézier ne donnera pas un
modèle exploitable pour l'impression. Il est nécessaire
préalablement de les convertir en maillage, afin de pouvoir nettoyer
le modèle avant l'export. 
Pour cela en mode objet, utilisez le raccourci [Alt C] et cliquez sur le
deuxième choix Mesh from Curve/Meta/Surf/Text. 
Mais on s'aperçoit en edit mode que le maillage généré par la
conversion n'est pas manifold. 

Ce problème peut être résolu rapidement en fusionnant les vertex
des parties frontales et ceux des parties latérales situés à la même
position. 
Il suffit de tout sélectionner avec la [touche A] et de supprimer les
doublons avec l'outil Remove Doubles [W]. 
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Et le résultat est un maillage fermé où les vertex sont communs aux
parties frontales et latérales. 

Il vous reste à faire de même pour l'autre objet courbe.

 

Pour une impression bicolore sur une imprimante avec deux
extrudeurs,  chaque couleur est à exporter en tant qu'un fichier .STL
propre, afin d'être plus facilement géré par le logiciel de l'imprimante. 
Pour la mise à l'échelle et la procédure d'exportation, se référer au
chapitre Exporter en .STL ou .OBJ. 
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chapitre Exporter en .STL ou .OBJ. 

Utiliser un bitmap pour modifier son maillage
Pour imprimer des objets au relief assez complexe, ou riche, il n'y a
pas méthode plus rapide que d'utiliser une texture issue d'une image,
de type photo ou dessin scanné. Cette image sera de préférence
enregistrée au préalable en niveaux de gris car Blender n'en
exploitera que les valeurs et pas les couleurs. Les variantes de gris
seront alors utilisées pour modifier l'épaisseur du maillage grâce au
modificateur Displace.

 (image
Lithophanie1_durchlicht_http_en.wikipedia.org_wiki_Lithophane.png)

Nous allons utiliser ce principe pour modéliser une lithophanie dont
les variations d'épaisseur serviront de décoration lumineuse.

Afin d'importer l'image comme un objet physique dans Blender, il est
plus simple d'utiliser l'add-on "import-export: Images as Plane".
Rendez-vous dans [File>User Preferences] et activez-le. 
Allez ensuite dans [Add > Mesh > Images as Plane] et sélectionnez
votre image.

 

Revenez sur la vue 3D et passez en mode Édition [TAB]. Pour réaliser
une lithophanie, une image en noir et blanc déplacera le maillage
subdivisé grâce à un modificateur. Afin de définir un cadre plan, non
affecté par la mise en relief, ultérieurement,  il est nécessaire
d'extruder les arêtes du pourtour du plan [Alt E > Extrude Only]. Par
défaut, l'extrusion est couplée avec une opération de déplacement.
Ici, la translation n'est pas souhaitée. Faîtes un clic droit pour
l'annuler.
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Désormais, il faut éloigner le pourtour extrudé du cadre par un
agrandissement [S] très léger d'une valeur de 1.01. 

Pour plus de clarté, l'agrandissement  a été éxagéré sur la capture
d'écran suivante.

Sélectionnez maintenant la face centrale; l'objectif étant de limiter
l'effet du déplacement de vertex  par notre image à cette face. Vous
devez pour cela créer un vertex group: 

Dans les propriétés du maillage, onglet vertex groups, cliquez sur le
[+] puis [assign]. 

Sélectionnez  l'intégralité des vertex [A][A] et mettez votre objet à la
taille à laquelle vous voulez l'imprimer [S] et mettez les normals
vers l'exterieur avec le raccourci [Ctrl + N]. 

Sortez du mode Édition [Tab].
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Tout comme les pixels de l'image définissent sa qualité de
résolution. Désormais, il faut densifier le maillage. Allez dans les
propriétés des modificateurs et ajoutez un modificateur
Multiresolution, sélectionnez Simple, cliquez sur subdivide 7 fois. A
chaque niveau de subdivision, chaque face est subdivisée en 4
nouvelles faces. 7 subdivisions suffisent pour les images avec peu de
détail. 

Ajoutez un modificateur [Displace]; sélectionnez votre image dans
texture ainsi que le groupe précédemment créé dans vertex group et
dans [Texture Coordinates] sélectionnez [UV]. 
Augmentez enfin la valeur absolue [strength] pour avoir un volume
satisfaisant. 
Le modificateur pousse les blancs vers le haut et les noirs vers le
bas. 
Puisque notre image n'est pas un négatif, il faut que la valeur
strength soit négative pour inverser ce comportement. 
Passez la valeur midlevel à 0 pour que rien ne soit au dessus du
cadre. Cette valeur par défaut à 0.5 permet de régler le niveau à
partir duquel commence la mise en relief. 

51



Le niveau de subdivision du modifier Multiresolution peut être plus
poussé pour un meilleur respect des détails. Cependant cela signifie que
le nombre de faces du modèles va passer de plusieurs centaines de
milliers de faces à plusieurs millions. Hors à ce niveau, suivant votre
configuration, le modèle peut être lourd à gérer. Avec l'image utilisée,
nous l'avons poussé jusqu'à 9.

Repassez en edit mode et sélectionnez uniquement le pourtour de
l'objet [Shift Ctrl Alt M]. D'abord extrudez-le et agrandissez-le
comme précédemment mais avec une valeur de 1.1 pour définir le
cadre de la lithophanie.
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Le maillage à 9 niveaux de subdivision est tellement dense qu'il
apparaît noir. Seules les faces étirées du cadre laissent apparaître des
mailles. Il peut paraître plus simple de faire les extrusions avant
d'appliquer les modificateurs. Mais dans ce cas, beaucoup plus de faces
inutiles vont alourdir le maillage. 

Grâce à la valeur midlevel à 0, le déplacement s'est fait sous le cadre.
Pour un déplacement avec une force positive, il aurait fallu mettre la
valeur midlevel à 1. 

Extrudez maintenant vers le bas pour donner une épaisseur à votre
objet (pas trop pour laisser la lumière transparaître mais
suffisamment pour lui donner assez de solidité).
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Enfin, refermez l'ouverture du maillage en faisant un Fill [Alt F]
plutôt qu'un Grid Fill générant plus de faces. 
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Modifier un maillage existant
Vous avez importé un fichier en vue de l'imprimer. Cependant, l'objet
n'est pas complètement satisfaisant pour votre projet d'impression.
Vous souhaiteriez lui apporter quelques modifications. Ce chapitre
est consacré à la réalisation de 2 modifications courantes, à savoir,
la séparation d'un objet en vue d'en conserver qu'une partie et la
personnalisation d'un maillage au moyen du Sculpt mode.

Séparer un maillage
Pour cet exemple, une voiture téléchargée depuis le site Thingiverse
servira de modèle. Le but est de lui en extraire une roue.
http://www.thingiverse.com/thing:45449

Seule la roue de ce modèle est utile. Comme ce fichier contient
plusieurs pièces, il faut l'éditer pour extraire la roue du reste du
maillage.

Dans un premier temps, il faut importer le modèle
car_thingi.stl dans Blender via File > Import > Stl (.stl)
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Le modèle est très grand. Vous aurez besoin de dé-zoomer pour
avoir une vue globale. Puis passez en Edit mode, touche [TAB].
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L’intégralité du maillage sera sélectionné, désélectionnez-le avec [A]
puis mettez le pointeur de la souris sur la pièce intéressante et
appuyez sur [L] pour sélectionner tous les vertex reliés par les
arêtes.

Enfin pour l'extraire du reste, appuyez sur [P] et choisissez [Selection]
dans le menu Separate.

Si vous choisissez [By loose parts], ce ne sera pas que la zone survolée
qui  sera séparée, mais toutes les parties qui ne seront pas rattachées à
une autre. Cette méthode peut être plus rapide si vous avez plusieurs
objets à séparer.

Pour terminer, sortez de l'Edit mode [TAB]. La roue est désormais
dans un objet séparé. Il ne restera plus qu'à l'exporter.
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Modifier le maillage avec Sculpt mode
Pour certains fichiers, il sera nécessaire de faire une vraie retouche
du maillage. C'est le cas en particulier, de ceux qui proviennent d'un
scan 3D. Si l'édition peut se faire avec les outils habituels de
sélection de faces, arêtes et vertex, cela peut cependant s'avérer
fastidieux.

Pour cet exemple, il s'agira de partir d'un maillage représentant une
pintade [pintade.stl]. Cette pintade mérite des modifications en vue
d'une impression de meilleure qualité, plus spécialement au niveau
du socle et de la tête.

Pour nettoyer ce modèle et lui ajouter quelques détails, le module de
sculpture (Sculpt mode) est certainement le plus approprié. Il va
s'agir d'utiliser une série d'outils qui modifieront le maillage avec des
options variées, se comportant un peu comme des doigts sur une
pâte à modeler. 

Comme précédemment, il faut commencer par importer le fichier
STL, puis passer en Sculpt mode :
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Pour que ce module fonctionne correctement, il faut désactiver
[Double Sided] dans les propriétés [Normals] du maillage.

Ce mode dispose d'un choix de pinceaux varié. La tablette graphique
est fortement recommandée pour utiliser ces pinceaux afin de
profiter des variations de pression fort utile pour ce genre d'exercice.
Mais si vous disposez d'une souris, cela fera l'affaire.

Parmi les options intéressantes et utiles des brosses disponibles en
Sculpt mode, le mode dynamique permettra d'ajouter des vertex
selon une résolution définie. L'activer permet d'utiliser la brosse
comme un véritable outil d'édition de maillage. Il est disponible mais
il est désactivé par défaut. Pour l'activer, passez par le panneau
[Tools] et cliquez sur le bouton (Enable Dynamic] de la partie
[Topology].
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La résolution sera gérée avec le réglage [Detail Size]. Plus ce chiffre
sera élevé, moins la résolution est fine. Par défaut, la résolution est
à 30 ce qui est bien pour commencer. L'option [Smooth Shading]
gomme les angles, il est déconseillé de l'activer pour l'impression
3D.

Afin d'ajouter des détails, il va aussi falloir choisir le type de brosse.
Celles-ci correspondent à des types d'action ou de résultats
attendus. On accède à la liste des brosses en cliquant sur l'aperçu
tout en haut du panneau [Tools]. Choisissez le pinceau [Crease] qui
permettra d'accentuer les angles.

Avec le Clic gauche, ce pinceau dessine des creux en resserrant le
maillage, et Clic gauche + [Ctrl] affirme les arêtes. Cela sera très
utile pour affiner le bec et y mettre les reliefs manquants.
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Avec [Maj] le pinceau passe en smooth, ce qui permet d'effacer les
angles et de détendre le maillage en le rendant plus régulier. Jouez
le cas échéant avec la dimension de l'outil en modifiant le réglage
[radius].

Le travail sur la pintade terminée, il est temps de s'occuper du socle
sur lequel elle tiendra. Dans un premier temps, supprimez le socle
actuel pour le remplacer par quelque chose de plus propre.
Repassez en Edit mode [Tab] et avec le pinceau de sélection [C],
sélectionnez tous les vertex du socle.
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Avec le pinceau de sélection, le bouton gauche sélectionne, et celui
du milieu désélectionne, alors que la molette change la taille du
pinceau. Pour confirmer la sélection, il faudra utiliser le clic droit.
Comme il est impossible de déplacer la vue pendant la sélection,
l'opération devra être réalisée en plusieurs fois afin d'avoir tous les
vertex du socle de sélectionnés. Dans ce cas, appuyez sur [Echap]
pour sortir de l'outil et vous déplacer dans la vue, puis réactivez le
[C].

Effacer ces vertex [X > vertex] puis refermez les pattes en créant des
faces [F] après les avoir sélectionnés par exemple avec [Select>Edge
Loop] sur la base d'une première arête (l'addon F2 est très utile pour
ce genre de travail). Si certains vertex n'étaient pas sélectionnés,
recommencez jusqu'à suppression complète du socle.

Afin de ne pas faire ce travail fastidieux deux fois, l'astuce ici est
d'effacer la patte de gauche pour la remplacer par une copie de
celle de droite. Sélectionnez les vertex de la patte gauche pour les
effacer sans crainte. Sélectionnez la patte de droite pour la
dupliquer [Maj D>Entrée]. Pour respecter la symétrie du corps,
appliquez un miroir sur l'axe des Y [Ctrl+M>Y>Entrée] et placez cette
patte à l'endroit désiré.
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Pour joindre cette patte au corps, sélectionner les deux extrémités
de chaque avec Alt+Clic droit puis Alt+Maj+Clic droit.

Il s'agit maintenant de créer un bridge pour attacher le corps à la
patte [W > bridge edge loops. Une fois raccordé, un dernier retour en
Sculpt mode est nécessaire pour unifier la modélisation et passer
quelques coups de brosse smooth.

La queue est actuellement assez longue et il faudra soit la raccourcir
soit fabriquer un échafaudage pour la supporter (voir chapitre dédié
en section 3). Pour éviter d'ajouter les supports d'impression, les
brosses Grab et Fill du Sculpt mode vous aideront  à redresser la
queue vers le haut.
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Pendant cette phase il est utile de faire des allers et retours en Edit
mode [TAB] afin d'utiliser l'outil de visualisation "Mesh Analysis",
pour vérifier l'angle des faces (type Overhang). L'angle par défaut
est de 45°, ce qui est parfait, mais des modifications sont possibles
en connaissance de cause.

Repassez en mode Objet [TAB] pour ajouter le socle, appuyer sur
[Maj A], ajoutez un cube, puis en Edit mode, mettez-le aux dimensions
souhaitées et retournez en Object mode.

Une fois placée à l'endroit désiré, sélectionnez la pintade et ajouter
un modificateur [Boolean] en opération [Union]. Cliquez sur la zone
Object pour faire apparaître la liste des objets de la scène et
choisissez le cube comme cible. La pintade est maintenant unie au
socle.

Il ne reste plus qu'à exporter l'objet au format STL et l'imprimer
(avec des échaffaudages).
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EXPORTER POUR L'IMPRESSION 3D

66



Analyser son maillage
Blender dispose de deux outils d'analyse de maillage destinés à
l'impression 3D : Mesh Analysis et 3D Printing Toolbox. Ces deux
fenêtres ont quelques paramètres identiques, mais la première est la
plus simple à prendre en main.

Le mode de visualisation "Mesh Analysis" 
 Le panneau d'analyse de maillage est disponible en mode Édition
dans les propriétés [N] avec un affichage solid.

 

Cet onglet permet d'activer différents types d'analyse du modèle en
mode Édition. 
N'étant pas compatible avec les modificateurs, vous devez soit
désactiver vos modificateurs mais dans ce cas leur action sur le
maillage ne sera prise en compte, soit les appliquer (clic sur le
bouton [Apply] dans la fenêtre de chacun des modificateurs).

Il colore les faces incriminées de variations de couleurs allant de
bleu à rouge selon les limites configurées. 
Il dispose de 5 types d'analyse: 

Overhang
permet de visualiser les faces dépassant l'angle paramétré par
rapport au sol, afin de réaliser des modèles avec le moins de
supports nécessaires; dans le cas du mug, les parties sortant
de la forme de base, bec et anse, posent clairement problème.
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de la forme de base, bec et anse, posent clairement problème.

Thickness
met en évidence les faces dont l'épaisseur peut poser
problème. Il s'agira de paramétrer le minimum et le maximum
d'épaisseur selon les besoins définis à l'impression et d'en
anticiper les problèmes. Dans l'exemple, on peut voir que
l'épaisseur est calculée selon l'orientation de la face. Ainsi, la
face supérieure de la tasse est considérée comme épaisse au
vu de toute la matière placée en dessous. En revanche, le bec,
juste créé avec une arête déplacée manque réellement
d'épaisseur. Il faut aussi avoir en tête que l'imprimante
n'imprime pas nécessairement la totalité d'une épaisseur, par
économie de matière première. 

Intersect
pour visualiser les faces qui se croiseraient; notre modèle par
défaut ne contient pas de croisement de faces. mais cela
pourrait être fréquent pour des objets plus complexes
(modèles de personnages par exemple). Le singe par défaut de
Blender est constitué de croisement au niveau des yeux. 
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Blender est constitué de croisement au niveau des yeux. 

Distortion
affiche les faces non planes (un ngon* dont les vertices ne
seraient pas sur le même plan); une fois encore, le bec et la
base de l'anse constitue des zones de déformation à regarder
avec attention au moment de l'impression. Il est important de
bien noter les angles à analyser selon la résistance des
matériaux utilisés et la capacité à supporter leur propre poids.
Plus l'angle de déformation est élevé plus la difficulté à
imprimer sera grande si la projection est volumineuse. 

Sharp
affiche les angles trop aigus. Ce seront des points à vérifier à
l'impression parce que le taux de précision nécessaire et la
fragilité peuvent impacter le résultat. 

69



fragilité peuvent impacter le résultat. 

L'add-on 3D print toolbox
Apparu dans la version 2.67 de Blender, cet add-on complète le
panneau Mesh Analysis et permet d'avoir une vue plus globale de
l'ensemble des problèmes. 

En cliquant sur le bouton relatif à un problème (celui qui contient le
nom du test, par exemple Thickness). Le résultat d'analyse apparaît
alors en bas avec le nombre de faces répondant au critère. Cliquez
alors sur cette zone de résultat pour sélectionner automatiquement
les faces.
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Volume
calcule le volume de son objet.

Area
calcule la surface de son objet (utile pour les impressions
céramiques où les prestataires calculent le prix par rapport à
celle-ci).

Solid
indique si le maillage est "non manifold" (volume non fermé)
et si les normals sont dans le bon sens, permet également de
sélectionner automatiquement les vertex incriminés.

Intersections
indique si des faces se croisent.

Degenerate
met en évidence les faces qui feront une taille nulle, ce qui
poserait des soucis sur certains logiciels.

Distorted
indique les faces non planes.

Thickness
indique les murs dont l'épaisseur est inférieure au paramètre
saisi

Edge Sharp
montrant les angles trop aigus.

Overhang
pour les faces dont l'angle par rapport au sol est inférieur au
paramètre.

Check All
pour faire une vérification sur tous les paramètres ci-dessus et
peut constituer une première approche pratique pour faire une
évaluation générale.

Isolated
supprime les vertex qui n'appartiennent pas à un volume et
évitera d'imprimer des formes non nécessaires.

Distorted
pour supprimer les faces non planes

Scale to Volume
modifie l'échelle de l'objet afin de lui donner un volume précis

Scale to Bounds
modifie l'échelle de l'objet afin de lui donner une longueur
maximum

Export Path
permet d'exporter l'objet sélectionné, les 2 boutons
permettent d'appliquer l'échelle à l'export pour le premier et
d'ajouter les mapping d'image dans le but des impressions en
quadrichromie (Zprinter de chez Zcorp) pour le deuxième.
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3D Printing Toolbox complète admirablement [Mesh Analysis] : 

contient plus d'options et affiche les quantités
travaille avec les modificateurs activés ce qui rend les

corrections plus faciles, mais les résultats gagneront tout
de même à être effectués sur des modificateurs appliqués

permet de sélectionner directement les faces
et aussi de fonctionner en mode filaire ce qui permet

d'accéder à des éléments invisibles comme dans ce cas de
l'[intersect] apparaissant à la base du mug qui n'était pas
évident avec Mesh Analysis. 
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Nettoyer son maillage
Afin d'avoir un modèle imprimable, il faut respecter quelques
contraintes. Certaines de ces contraintes sont évidentes alors que
pour d'autres un passage par les outils d'analyse sera pratique.

Épaisseur  
Respecter la taille minimum imprimable des murs, selon
l'imprimante utilisée cette taille varie, en générale, il ne faut pas
descendre sous les 0.8mm. Adaptez bien vos réglages d'échelle et
vos unités dans la scène en fonction de l'échelle d'impression, car
vous pourrez aussi créer un modèle plus petit que vous mettrez à
l'échelle avec vos logiciels d'impression (même si cela ne simplifie
pas la tâche).

La solution consiste à utiliser l'add-on [3D Printing Toolbox] afin de
voir les zones trop fines et soit agrandir la taille du modèle en
général, soit augmenter l'épaisseur des parties incriminées en les
déplaçant. Si vous avez utilisé le modificateur [Solidify], vérifiez le
réglage [Thickness] et [Even thickness].

Maillage ouvert (non-manifold)
La présence d'ouverture par le biais de faces qui n'ont pas de voisine
peut aussi être une difficulté. Il ne faut donc  pas avoir de maillage
"non manifold", c'est a dire de volume ouvert, comme un cube a 5
faces seulement par exemple . 

La solution est de passer en mode Édition, dans le header de la vue
3D, menu [Mesh > Clean up > Fill Holes]. Si vous avez utilisé le
modificateur [Solidify], vous limitez déjà ce risque mais contrôlez
moins vos épaisseurs que modélisation par face mais vérifiez que
l'option [Fill Rim] a bien été activée.

Faces non planes
Les faces non planes sont des faces considérées comme tordues. En
général, elles sont dues au fait qu'un vertex n'est pas sur le même
alignement que les autres. Cela arrive le plus souvent sur des faces
quadratiques.

Utiliser l'add-on [3D print toolbox] et son bouton cleanup
[Distorted], ou en mode Édition, dans le header de la vue 3D, utilisez
le menu [Mesh > Clean up > Split non-planar faces]. Blender va
scinder la face en 2 de manière à tenir compte de l'orientation
spécifique de ce vertex.
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Nombre de faces trop important
Dans le cas d'un scan ou d'un sculpt, le nombre de faces peut être
trop élevé pour être géré par le logiciel de création de gcode (fichier
de contrôle d'imprimante). C'est aussi le cas lorsque le modificateur
de [Subdivision de surface] est utilisé abusivement sur des maillages
contenant déjà un nombre de faces assez élevé.

L'utilisation du modificateur [Decimate] permet de réduire
efficacement ce problème en tentant de préserver la forme globale.
Le réglage important est le [Ratio] : lorsqu'il est de 0, toutes les
faces seront supprimées et lorsqu'il est à 1, le maillage n'est pas
modifié. Il convient donc de trouver le meilleur paramètre en
fonction du nombre souhaité. 

 

Intersection de faces
Les faces coupant d'autre faces sont à éradiquer. Cela est
particulièrement vrai lorsque les faces ne sont pas dans la même
orientation mais se coupent en créant un angle. Selon la taille de la
zone d'intersection le résultat imprimé pourra être plus ou moins
décevant.

La solution est alors manuelle. Il faudra déplacer les vertex hors du
volume d'intersection.

Si un modificateur [Solidify] a été appliqué, vérifiez que la valeur du
réglage [clamp] qui peut parfois engendrer ce type d'erreur si elle
n'est pas adaptée au maillage. Ici avec un [clamp] à 2, une seule face
est intersectée alors que la quantité passe à 145 si le [clamp] est à 0.
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Vertices et faces isolés 
Les vertex isolés et les faces isolées sont à exclure sont souvent des
restes oubliés ou encore des objets séparés. Dans le premier cas ils
sont inutiles, dans le second, il faudra éventuellement séparer les
objets comme vu au chapitre Importer des modèles 3D et les
imprimer séparément. 

Pour supprimer les éléments oubliés qui n'appartiennent utilement à
aucun maillage utilisez l'add-on [3D print toolbox], cliquez sur le
bouton [Isolate] de la zone [Cleanup].

Cette fonction ne supprimera que les arrêtes et vertices isolés. Si les
objets à supprimer contiennent plusieurs faces, il faudra :

1. les supprimer manuellement avec [RMB];
2. [L] pour étendre aux arrêtes reliées 
3. puis [X] pour supprimer.

Angles aigus
En cas d'angles trop aigus, vous retombez dans le cas de figure d'un
manque d'épaisseur. Il faudra en général épaissir en générer de
nouvelles faces qui pourront être ensuite déplacées. Cela modifiera
bien sûr l'aspect de l'objet et il faut que cela soit possible.
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Échafauder son maillage
Les logiciels d'impression 3D sont tous capables de créer des
supports automatiquement, mais cet automatisme n'est pas parfait
car souvent cela double le temps d'impression. Dans le cas des
imprimantes à plusieurs têtes, il sera possible d'imprimer
l'échafaudage dans une matière, par exemple qui se dissout à l'eau.

Ajouter manuellement dans Blender des supports aux endroits
nécessaires reste donc une solution incontournable.

Pour cet exercice, nous allons partir de la primitive de Blender,
Suzanne, que l'on a pris soin de rendre manifold en fermant le
maillage au niveau de ses yeux.

Grâce au [Mesh Analysis] (cf chapitre "Analyser son Maillage") en
type [Overhang], vous pouvez repérer aisément les zones à soutenir.
Elles seront représentées en couleur chaude allant du jaune au
rouge. C'est évidemment en général dessous la forme qu'il faut
regarder [Ctrl NumPad 7]. 

Pour créer cet échafaudage, désélectionnez tout [A] et ajoutez un
cube sous le modèle, puis éditez-le pour supprimer 4 de ses faces
afin de n'en conserver que 2.
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En mode de sélection par arête, ajuster les dimensions de ces plans,
dupliquez-en au besoin [Maj D], veillez à faire rentrer ces faces dans
le modèle aux emplacements les plus marqués par le mesh
analysis.

Dupliquez le plan central [Maj D] et séparez-le de l'objet
[P]>Selection

Revenez en mode objet, sélectionnez le  nouvel objet et repassez en
edit mode, faites le tourner sur l'axe Z de 90° [R]>[Z]>90
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Comme pour les autres plans, placez à l'endroit les plus horizontaux
du modèle (les zones les plus rouge du montré par mesh analysis,
en mode overhang), en extrudant les arêtes verticales

Maintenant, il faut donner de l'épaisseur à ces deux objets, avec des
modificateurs [Solidify] à 0.5 de [Thickness].
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Ajoutez un modificateur [Boolean] en mode [Union] pour unir les 2
objets supports, et un autre [Boolean] en mode [Difference] pour
soustraire la forme du modèle du support.

À ce moment vous avez deux choix, soit exporter votre support et
votre modèle dans le même fichier Stl, soit si vous disposez d'une
imprimante à double extrusion, exporter votre modèle et votre
support dans 2 fichiers séparés afin d'imprimer le support dans une
matière soluble.

Dans le premier cas, sélectionnez  les deux (clique droit sur le
premier et shift clique droit sur le deuxième) puis exportez en Stl,
dans le deuxième cas, exportez-les l'un après l'autre à l'aide de la
fonction d'export du panneau [3D Print].
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Exporter au format STL et OBJ
Il existe deux grands formats d'export courants pour les maillages
en vue de l'impression 3D : le STL et le OBJ. Le STL, pour
STereoLithography, a été d'emblée conçu pour l'impression 3D et
c'est lui qui sera utilisé dans la majorité des cas, car il ne mémorise
que les informations géométriques nécessaires à l'impression. Le
format OBJ sera utilisé dans des cas particuliers, plus évolués mais
aussi plus rares.

Dans tous les cas, il est conseillé de garder le modèle de base au
format blender .blend qui permettra de retoucher beaucoup plus
facilement au fichier.

Préalablement à tout export, il faut penser à : 

centrer l'objet à l'origine de la scène afin d'obtenir un
objet centré à l'ouverture dans le logiciel générateur de g-
code [Alt G].

Agrandir l'objet pour que ses dimensions correspondent à
la taille voulue avec pour repère une unité blender égale à
un millimètre.

Valider l'échelle de l'objet comme l'échelle de référence
[Ctrl A>Scale]. 

Exporter en STL
L'exportation en STL va donc mémoriser le maillage sur forme de
géométrique triangulée. Elle va  permettre d'obtenir un modèle 3D
standard à partir de notre document Blender, sans les éléments
additionnels non nécessaires : textures, couleurs, animations... Ce
fichier STL vous sera demandé lors d'une impression en ligne, ou lors
d'une impression locale.

Une fois la fonction d'export en STL activée, des options
apparaissent dans la Toolbox :

parametre exportation STL

Ascii 
L'option [Ascii] permet de créer un fichier STL lisible dans un
éditeur de texte.

Apply Modifiers
La case [Apply Modifiers] s'occupe d'appliquer les
modificateurs influant sur la géométrie de l'objet pendant
l'export. En théorie, les modificateurs ont déjà été appliqués
avant la phase d'analyse et de nettoyage du maillage. En
pratique, garder cette option active pour l'export d'un objet
sans modificateurs ne peut pas nuire à l'export.

X, Y, Z
Le choix de la lettre indiquant l'axe de la hauteur est arbitraire
dans les logiciels de 3D. La plupart du temps, l'axe choisi pour
définir la hauteur est l'axe Z ou Y. Dans Blender, la vue de
dessus (Top) est dans le plan YX et donc la hauteur correspond
à l'axe Z. Blender peut alors être qualifié de logiciel en Z up. La
vue de face (Front) est dans le plan ZX et donc la profondeur
de cette vue correspond donc à  l'axe Y.  
Vous devez changer les options Up et Forward pour adapter le
fichier exporté au comportement du logiciel dans lequel sera
ouvert le fichier STL. 

Scale
La valeur [Scale] permet également de réduire ou d'agrandir la
taille de l'objet exporté, si l'on connaît les préférences de la
plateforme pour laquelle le .STL sera traduit en impression 3D.
La plupart des logiciels d'imprimantes s'exprime en mm et
considèrent pour une valeur Scale à 1 qu'une unité blender est
égale à 1 mm. 
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Si ces options sont ignorées, le modèle sera peut-être importé dans
le mauvais sens avec une rotation de 90° ou trop grand ou trop petit
. Cela n'a rien généralement de dramatique puisque quasiment tous
les logiciels tiers d'imprimante ou plateforme d'impression en ligne
offre généralement la possibilité de faire une rotation 90° ou une
mise à l'échelle du modèle avant impression. Cependant, dans le cas
d'un processus automatisé qui utiliserait directement le fichier .STL, il
vous revient de tester et de définir une procédure à suivre. 

Le format .ply avec lequel Blender est compatible a été prévu pour
résoudre certains défauts du STL mais n'est pas aussi utilisé.

Exporter en OBJ
Par rapport au STL, le format OBJ va permettre d'avoir plusieurs
couleurs sur le modèle 3D. La plupart des méthodes d'impressions
sont basées sur des matériaux monochromes, le STL sera alors
largement suffisant. Mais il existe des imprimantes 3D à
quadrichromie utilisées par les services en ligne et il est possible de
penser qu'elles vont peu à peu se répandre.

Le format .OBJ est un standard commun à la plupart des logiciels de
3D quel que soit leur domaine. Beaucoup d'options de l'export n'ont
pas d'intérêt pour l'impression 3D. 

Pour exporter, il faut aller dans le menu Fichier > Exporter
[File>Export] ce qui affiche le panneau spécifique, évidemment plus
complet que celui du STL, puisque le OBJ inclut aussi des options
plus utiles dans le rendu.

 

Les options [Apply Modifiers], [Forward], [Up] et [Scale] sont les
mêmes que celles décrites pour le format STL.  Quelques autres
options peuvent cependant se rendre intéressantes : 

selection only 
L'option [Selection Only] permet de limiter l'export aux objets
sélectionnés dans la scène. Très pratique si vous ne souhaitez
imprimer qu'une partie d'un ensemble sans vous battre avec
chacune d'entre elles et enregistrer des fichiers
intermédiaires..

triangulate faces 
L'option [Triangulate Faces] change les faces quadrangulaires
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L'option [Triangulate Faces] change les faces quadrangulaires
en triangles. Le triangle est la face de base pour toutes les
machines. Mais un modèle uniquement composé de triangles
est moins simple à comprendre pour un humain que pour une
machine. Heureusement, chaque rectangle, carré ou losange
peut être interprété comme deux triangles co-planaires. En
théorie, le maillage doit être triangulé avant la phase
d'analyse et de nettoyage.

write materials 
Pour colorer votre modèle, il faut qu'il possède un matériau et
une texture diffuse mappée selon des coordonnées UV.
Souvent les plateformes d'impression ne supporte qu'une
seule texture et un seul canal de coordonnées UVs [UVmap]. 
Si vous souhaitez exporter de la couleur, cochez [Write
Materials] et [Include UVs]. 
Les propriétés du matériau seront stockées dans un fichier
.MTL créé au même endroit que l'.OBJ. 
Si vous passez par un service en ligne, il vous sera alors
demandé de transmettre l'.OBJ, le .MTL et le fichier image
(.jpeg ou .png) correspondant à la texture dans une archive
.zip. 

Après avoir vérifié vos paramètres, et choisi un chemin pour votre
fichier, renseignez le nom de celui-ci :  

Puis cliquez sur le bouton Export OBJ. 

Vous obtenez ainsi votre modèle exporté depuis l'interface de base

Exporter à partir du 3D PrintPour un travail récurrent d'impression 3D, l'add-on [3D Print
Toolbox] possède 3 lignes d'options qui permet de faciliter le travail
d'export. Il aura l'avantage de prendre en compte la sélection
uniquement et d'offrir un panel d'autres formats. 

Le premier bouton reprenant reprenant l'icône du [Scale] sert à
prendre en compte les unités de la scène lors de l'export. 
Le second bouton copie les fichiers des textures Image dans le
même répertoire que celui indiqué pour l'export à la ligne en
dessous. 
Par défaut, le format d''export est le .STL mais vous pouvez le
changer pour un autre format (PLY,X3D,VRML2 ou OBJ).

La ligne contenant les // permet de choisir le dossier d'export. Le
nom du fichier exporté sera quand à lui basé sur celui du fichier
blender. 

Ces préférences sauvegardées, une bonne fois pour toutes, la phase
d'export ne se limitera plus qu'à appuyer sur le bouton [Export] à
chaque fois que cela sera nécessaire. 
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Où imprimer ?
À présent que le fichier est soigné, il est prêt pour la prise en charge
par la machine. Quelques services d'impression en ligne
apparaissent aujourd'hui, aussi bien sur le web qu'au coin de la rue. 

Sur le web
Les spécialistes 

Les incontournables du web marchand sont i.materialise, sculpteo,
shapeways et cubify. Il s'agit ici de spécialistes offrant sur le web
divers procédés et divers matériaux. La prestation est soignée, il en
va de la réputation du "Cloud Printing", l'impression 3D déportée
«en nuage» qui repose sur des plate-formes physiques, implantées
sur tous les continents. Ces outils en ligne tendent à rendre le
processus le moins douloureux possible pour l'usager, et
l'expérience agréable. Un transfert de fichier et un calcul de prix
selon le matériau et la dimension choisie, et l'affaire sera réglée et
livrée sous quelques jours par la Poste, si besoin par transporteur.
Les matériaux et les frais de port aidant, ces services sauront
d'autant satisfaire l'utilisateur livrant un .stl impeccable car les
"ratés" coûtent chers. Les formats supportés sont nombreux et
varient selon les sites marchands. Le .stl et le .obj restent toutefois
les plus universellement intégrés. Format supportés -
http://www.shapeways.com/tutorials/supported-applications?
li=nav 

capture d'écran objets différentes couleurs/ différents matériaux. 

Les matériaux sont plus ou moins les mêmes au menu des diverses
offres commerciales. On retrouve les plastiques blancs ou colorés,
et dont les propriétés vous offrirons divers niveaux de finition,
l’Alumide, mélange de polyamide et de fines particules d’aluminium
permettant d'obtenir des pièces particulièrement résistantes, les
cires, par exemple pour les tirages "à la cire fondue" que l'on
retrouve souvent en bijouterie, les résines, qui se destinent plus
particulièrement aux rendus métallisés ou plaqués de métaux
précieux par la suite. Certains vous proposeront aussi de la
céramique (par émaillage à chaud d'une pièce imprimée). Il y en a
pour tous les goûts et vous devriez pouvoir y trouver votre bonheur.
Vous adapterez la résolution de votre modèle en fonction de la
destination de l'objet final. Nul besoin de transférer un fichier aux
millions de facettes s'il s'agit d'un tirage céramique, qui sera un peu
lissé naturellement par le procédé utilisé. 

Les généralistes 

Sur le même modèle mais plus généraliste, vous trouverez le
Néozélandais Ponoko, service de fabrication étendu qui propose,
toujours depuis votre clavier et à l'international, découpe & gravure
laser, impressions et même prototypage électronique. Son
partenariat avec Formulor (DE), Vectorealism (IT) et RazorLab (UK)
lui permet d'être présent en Europe, celui avec Sparkfun (US) ajoute
au site la possibilité d'intégrer de l'électronique à votre projet. Son
rapprochement avec le fabriquant de fraiseuses à commande
numérique shopbot élargi encore son offre en proposant une
communauté de plus de 600 professionnels capables de réaliser
votre demande. L'idée de 100K Garage consiste à vouloir faire circuler
des idées plutôt que des objets physiques, réalisés localement. De
quoi savoir faire et le faire savoir... 

La magie du web offre aussi le service

http://www.3dhubs.com/#about. Le principe, dans les grandes
lignes, consiste à mettre du temps d'impression sur le marché des
utilisateurs. En référençant ses machines, autrui peut louer son
service à un tiers, devenant le temps d'une impression, une sorte de
mini usine. Ce choix pourrait aussi s'avérer judicieux pour produire
rapidement et en quantité une pièce identique, en opérant de
manière parallélisée. Imprimantes de tous les pays, unissez-vous !
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 L'initiative nord américaine «100K Garages», un réseau décentralisé
de professionnels ayant à disposition une fraiseuse numérique (bois
principalement), permet d'offrir  <<a decentralized network of shop-
bot manufacturers in North America>>.

La longue traîne des objets 

En explorant plus avant les sites web suggérés, vous remarquerez
que certaines de ces plate-formes jouent pleinement des options
ouvertes par le web et proposent aux auteurs de modèles 3D de
devenir revendeurs de leur production imprimée. Grâce aux plus
abouties de ces plate-formes, s'offre à vous la possibilité de vendre
des objets embarquant même de l'électronique. Devrions nous
parler d'artisanat à la sauce 2.0 ? 

En guise de dessert, le Sugar Lab saura peut être vous satisfaire.
Reste à savoir si l'addition est aussi soluble que cette prestation est
sucrée ? 

Au coin de la rue 
Pour celles et ceux que les nuages rebutent, des solutions pointent
le bout du nez dans le monde physique. Depuis quelques temps sont
apparus, pour le moins en France, des services d'impression grand
public. Auchan, Top Office, et même La Poste testent depuis peu ce
service auprès du public. L'offre est certes plus restreinte mais reste
à un tarif abordable. Ici aussi, on teste le potentiel d'un marché
auprès des consommateurs.

Pour celles et ceux qui voudraient plonger plus avant et comprendre
comment tout ceci fonctionne ou simplement pour acquérir un tour
de main supplémentaire, rendez-vous est pris :

dans les Fablabs, LABoratoires de FABrication souvent
associatif et parfois public, mixant le numérique et les
savoirs manuels pour le plaisir et la progression de tout un
chacun;

dans les Makerspaces, Laboratoires parfois associatifs,
parfois informels, souvent activiste, où l'improbable peut
prendre libre forme et engendrer l'étincelle amusante;

dans les Techshops qui devraient prendre place, centres
commerciaux de ressources matérielles, où l'abonné peut
réaliser des prototypes à la pointe de la technologie.

Quelle que soit la saveur, ces lieux plus ou moins marchands sont
autant d'opportunités offertes à celui qui cherche à envisager le
numérique et la fabrication autrement.

Il s'agit là avant tout de se réapproprier et de concilier le savoir et le
faire, numérique ou pas, l'impression 3D offrant un outil
supplémentaire pour explorer cet univers qui s'offre à vous. 

Chez soi
Depuis mars 2005 et l'ouverture du blog, le projet RepRap
(contraction de "replicating rapid prototyper" que Wikipedia France
propose de traduire par «concepteur de réplication rapide») à fait
beaucoup de chemin, et surtout beaucoup d'émules.
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Initié à l'origine par Adrian Bowyer et l'université de Bath pour
étudier l'évolution des machines capables de se répliquer elles
mêmes, ce projet Open Source à généré une multitude d'adaptations
de la part de sa communauté d'utilisateurs/trices. On trouve en effet
aujourd'hui une multitude de variantes, commerciales ou non, plus
ou moins abouties, plus ou moins performantes, mais qui toutes
répondent à un besoin spécifique. Ces variantes permettent
d'envisager l'extrusion 3D sous divers angles. Certaines d'entre elles
sont spécialisées dans l'impression grand format (LeBigRep), d'autre
s o n t pliables (Foldarap) pour être facilement transportables,
certaines impriment avec du chocolat (Choc-Creator),  du sucre
(CandyFab) ou proposent tout simplement une électronique plus
avancées que la moyenne (Asimov).

Certaines n'existent pas en kit et ne verront le jour que si vous
décidez de les fabriquer à partir des sources et des plans mis à
disposition par les concepteurs, ou si un particulier particulièrement
enthousiaste se décide à vendre des pièces sur un site web
marchand. Malgré le temps consacré à l'achat des divers matériels
ainsi qu'à l'assemblage, cette option reste cependant la meilleure
façon d'appréhender la richesse de l'impression 3D Open Source et
de faire de substantielles économies.

Enfin, certaines machines sont livrées chez vous en kit, d'autres
encore vous parviennent prête à l'emploi. Parmi cette multitude, on
trouve des projets dont l'objectif est de faciliter la prise en main de
ces outils par le grand public, les impatients ou les plus fortunés.
Citons parmi les plus connues les exemples de la Makerbot, de
l'Ultimaker, du Cube ou encore les prochains modèles Form1 ou
Bucanneer. Pour 2 à 3 milles euros selon les versions, les options ou
les techniques employées, vous pourrez vous offrir à domicile les
services de ces machines clairement orientées vers la facilité
d'utilisation.

Concrètement, comment cela se passe-t-il avec sa
propre machine ?
Pour illustrer le propos et vous donner un aperçu qui vous
permettra de vous situer par rapport à vos besoins, nous
détaillerons la procédure complète d'impression sur une suite
logicielle.  Repetier et son compagnon Slic3r, un logiciel qui vous
permettra de gérer l'importation du .stl, sa conversion en gcode,
puis son transfert vers la machine.

Slic3r est un logiciel de création de G-code, il calcule les trajets de la
tête d'impression et le débit de plastique. 
Vous devez le configurer selon les paramètre de votre machine, la
taille de son plateau, le diamètre du filament, le type de plastique
etc. 
Une fois correctement configuré, il est très simple à utiliser et
rapide pour générer du Gcode. Vous n'avez qu'à ouvrir le Stl, cliquer
sur "Export G-Code..." et attendre qu'il le génère.
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Une fois le G-code produit, vous devez utiliser Repetier (ou un autre
logiciel pour contrôler votre machine).

 

Repetier permet de visualiser le chemin créé par Slic3r et l'envoyer à
l'imprimante, il gèrera la chaleur de l'imprimante, le déplacement
de la tête et le débit du plastique d'après le G-code. 

En Conclusion
Sur le fond, il n'y a rien de vraiment neuf sous le soleil. La couche
numérique n'apportera rien à votre projet si vous ne respectez pas
les formalismes minimaux qui permettent à tous d'échanger des
fichiers. Si vous n'y accordez pas un peu de "logique métier",
autrement dit. Quel que soit le logiciel et la machine choisie,
l'attention apportée à la fois à votre fichier.stl et au paramétrage de
vos réglages d'imprimantes, vous ouvrira les portes d'un Eldorado
qu'à condition que vous livriez un plan en bonne et due forme à vos
interlocuteurs. Comme un architecte livre un plan parfaitement
coté à un charpentier, finalement.

Pour ceux qui aime les dernières avancées, nous vous conseillons de
suivre l'actualité du projet ambitieux Peachy Printer. Cette
imprimante devrait devenir la moins chère du marché car elle n'a
aucune électronique embarquée, tout est géré par l'ordinateur sur
lequel le boîtier de la Peachy est relié. Son pilote devrait être un
simple addon pour Blender.
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ANNEXES
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Glossaire
Ce glossaire est là pour vous expliquer les termes employés dans ce
livre.

Add-on
Morceau de logiciel permettant d'enrichir les fonctionnalités
d'un programme donné (ici Blender). On pourrait aussi parler
de plugin, ou d'extension. Dans Blender, certains Add-on sont
activés par défaut et d'autres non.

Mesh, Maillage
Le mot maillage est utilisé pour parler d'un objet 3D du point
de vue de constituants techniques particulier rendus par une
multitudes de points reliés les uns au autres, un peu comme un
filet. Le maillage est une forme majeure de la modélisation 3D
qui contient aussi d'autres types d'élément comme les courbes
de bezier, les NURBS...

CAD
Computer Aided Design CAD est le sigle anglais pour la
Conception Aidée par Ordinateur CAO. De fait, les noms des
logiciels de CAO sont souvent anglais et incorpore le sigle
anglais dans leur nom: FreeCAD, QCAD, OpenSCAD,
HeeksCAD ... 

SVG
Le SVG, scalable vector graphics, est un format d'image
vectorielle. Il est une recommandation du W3C, même
organisme qui gère le développement du langage HTML. 

Extruder
Extruder est un procédé de fabrication consistant à donner
forme à un objet. En 3D, il définit plus particulièrement le fait
de produire de parties d'objet (vertex, arrêtes, faces) à partir
d'autres existantes par une copie qui sera liée aux originales. 

Libérathon
Mot-valise associant liber- (origine des mots « livre » et
« libre ») et -athon (de « marathon ») désignant la
méthodologie développée par Floss Manuals francophone
pour écrire un livre collaboratif en un temps restreint.

Support matériaux
Dans les logiciels vous trouverez des fonctionnalités que l'on
peut traduire indifféremment par support matériaux, supports
d'impression ou encore échafaudage. Cela désigne tous les
ajouts réalisé afin de faire en sorte que l'impression puisse se
réaliser sans que l'objet se casse sous son poids. Après
l'impression, il est donc nécessaire de les supprimer pour
délivrer l'objet.

BUGParis
Blender User Group de Paris. Groupe d'utilisateurs se
réunissant autour du logiciel 3D Blender à Paris chaque
premier samedi du mois.

Modificateur
Un modificateur est un outil de Blender permettant d'agir sur
un maillage de façon dynamique.  Il tient son nom du fait qu'il
modifie la forme et recalcule sa modification au fur et à
mesure de la modélisation.

Vertex
Point ou sommet d'un maillage

Manifold
Volume fermé. Il sera plus souvent question de maillage non-
manifold, non-fermé à cause des problèmes qui peuvent en
découler dans la structure.

NGon
Face formée de plus de 4 vertices. Pour retrouver des faces
classiques dans Blender, il faudra utiliser les raccourcis [Ctrl T ]
ou [Alt J]. 
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